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SPFE essentially generates the designs for symmetrical and asymmetrical factorial 
experiments and also performs the analysis of the data generated. It generates randomized 
layout of the designs for factorial experiments with or without confounding. The software 
requires user input as a list of independent interactions to be confounded. Different 
interaction(s) can be assigned for confounding in different replications. It also generates 
regular fractional factorial plans for symmetrical factorial experiments. The data are analyzed 
as per procedure of blocked/ unblocked designs for single factor experiments. The treatment 
sum of squares can be partitioned into sum of squares due to main effects and interactions. A 
null hypothesis on any contrast of interest can also be tested.  
 
The package is also useful for illustration purposes in the classroom teaching as well as for 
the researchers in Statistics with interest in experimental designs particularly in factorial 
experiments.  
 
It is user-friendly, interactive and Password protected Software. It is completely Menu-
Driven and can also be operated using the TOOLBARS of SPFE.  
 
Complete Help with Index, Contents and Search facility is available. The package can be 
run without the aid of a manual.  
 
There is a facility of changing the Password during installation time. The package is 
completely Standalone and is compatible with the Latest Technologies. It runs on 
WINDOWS Platform.  
 

 Why SPFE? 
Agricultural and industrial scientists/research workers conduct experiments in complete 
factorial experiment without confounding in two or three levels of factors using a randomized 
complete block (RCB) design. For small number of treatment combinations, an RCB design 
may be the most efficient design due to no loss of information in estimating factorial effects 
as well as block effects. However, with the increase in number of factors and/or levels of 
factors, the number of treatment combinations increases too rapidly. As a result the sizes of 
the complete blocks become large and thus failing to maintain homogeneity within blocks. 
This results in large intra-block variances and lower precision of the estimates of treatment 
contrasts. In such situations, the concept of confounding has been advocated.  The generation 
of appropriate confounded factorials is one issue due to a complex process and obtaining the 
randomized layout of the design is the other. The experimenters may also have a fear in mind 
regarding the analysis of the data generated from these designs and then interpreting the 
results. 
 



SPFE 1.0 

 I-92

Keeping these problems in mind this package has been developed. Users/ experimenters will 
not have to seek any help in selecting, generating, randomizing the design or analyzing the 
data generated. The main features of this package are 
• Generation of the design 
• Randomized layout of the design 
• Analysis of the data generated from block/unblocked designs for single and multi-

factor experiments 
• Probability generation 

 
Figure 1: First screen of SPFE after entering password 

Besides the above, the package also works as an Editor with limited facilities viz. opening, 
saving and printing of files, cut, copy, paste of the text and undo of the last action.  
 

 How to use SPFE? 
SPFE can be run either using Menu-Bar or Toolbar. The following options are available in 
the Menu-Bar: 
♦  File 
♦  Edit 
♦  View 
♦  Design Generation 
♦  Analysis 
♦  Probability Generation 
♦  Help 
The File Menu consists of various Sub Menus (Sub Options) 

• New 
• Open 
• Close 
• Save 
• Save As 
• Print 
• Change Password 
• Exit 
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The Edit Menu consists of various Sub Menus (Sub Options) 
• Undo 
• Cut 
• Copy 
• Paste 
• Clear text 
• Select all 

 
The View Menu consists of various Sub Menus (Sub Options) 

• Toolbars 
• Status Bar 

On enabling (selecting) the Toolbars, the following tools of SPFE are displayed  
WOC  Block Design for Complete Factorial Experiment without Confounding  
WC  Block Design for Complete Factorial Experiment with Confounding 
FF  Fractional Factorial Plan 
BCD   Balanced Confounded Design 
UBDS  Analysis of unblocked design (Single Factor) 
BDS  Analysis of blocked design (Single Factor) 
UBDM  Analysis of unblocked design (Multiple Factor) 
BDM  Analysis of blocked design (Multiple Factor) 
MEI  Main Effects and Interactions 
SDF  Single Degree of Freedom Contrasts 
UDC  User Defined Contrasts 
t  t-Probability Distribution 
2χ   2χ - Probability Distribution 

F  F -Probability Distribution 
 
On disabling (selecting again) the Toolbars, one gets all the tools of SPFE Editor Tools viz. 
Symbols of 

Opening New/ Existing Document 
Save 
Cut 
Copy  
Paste 
Print 
Undo, etc. 

      
The Design Generation module has the following four options viz. 
(i) Complete factorial without confounding  

(ii) Complete factorial with confounding 
(iii) Fractional Factorial Plans 
(iv) Balanced Confounded Designs 
 
On selection of Complete Factorial without Confounding Option, a Window Dialog Box 
will open up that asks the following parameters from the user 
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Factors (i.e., the number of factors, n) 
Levels   (i.e., the number of levels of each factor, s) 
Replications (i.e., the number of replications of each treatment combination, r) 

 
Please note that the above Window Dialog Box can also be selected by using the icon marked 
as WOC from the toolbar. 
 
The Window Dialog Box has a Check Box of the Randomized Layout button. Enable the 
Check Box if the Randomized Layout of the Without Confounded Design is required. 
  
There are two more buttons on this Window Dialog Box viz. OK and Cancel. The 
randomized complete block design for complete factorial experiments or the randomized 
layout is generated on pressing OK button. The Cancel button can be used to cancel the 
operation. 
 
To generate a Confounded Design, select the Complete Factorial with Confounding 
Option.  On selection of this option, a Window Dialog Box will open up that asks the 
following parameters from the user 

Factors (i.e., the number of factors, n) 
Levels   (i.e., the number of levels of each factor, s) 
Replications (i.e., the number of replications of each treatment combination, r) 

 
Please note that the above Window Dialog Box can also be selected by using the icon marked 
as WC from the toolbar. 
 
For the generation of Randomized Layout of Confounded Design, enable the check box of 
the Randomized Layout button. If the Check Box is left disabled, the confounded design 
without randomization will be generated.  
 
Similar to the Without Confounding option, there are two more buttons on this Window 
Dialog Box viz. OK and Cancel. The Cancel button can be used to cancel the operation. On 
clicking the OK button, the next Window Dialog Box gets opened up. This dialog box is for 
the information on the confounded interaction components for the first replication. The user 
has to enter 
• Number of independent interaction components to be confounded  
• The confounded independent interaction components.   
 
The number of independent interaction components should lie between 1 and n-1, where n is 
the number of factors entered on the last Window Dialog Box.  Once the number of 
independent interaction components to be confounded is entered, a Dialog Box on the same 
window for entering the interaction components to be confounded appears. This Dialog Box 
is like a spreadsheet. The number of columns in this spreadsheet is same as the number of 
factors and number of rows is same as the number of independent interactions to be 
confounded. The columns of this spreadsheet represent the factors denoted by A, B, C, … and 
the rows are marked by the number of independent interaction components. The independent 
interaction components confounded are then entered as the exponents (between 0 and s-1, 
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where s is the number of levels of each of the factors) of the different factors. The zero 
exponent represents that the particular factor is not involved in the confounded interaction. To 
be clearer, consider the following example; suppose the independent interaction components 
to be confounded in a four factor factorial with number of levels for each of the factors greater 
than or equal to three are 111121 DB,DCBA . The exponent entry for these interaction 
components is done as: 
 

 A B C D 
Interaction 1 1 2 1 1 
Interaction 2 0 1 0 1 

 
The above Window Dialog Box has two more buttons viz. OK and Cancel. The Cancel 
Button is used to Cancel the operation while pressing OK generates the first replication and 
then the dialog box for the second replication appears. The process is continued till the 
information regarding the number of replications entered is supplied.  On the Dialog Box for 
the last replication, the use of OK button, shows Progress bar Dialog Box. 
 
For the Generation of Fractional Factorial Plan, select the option Design Generation from 
the Menu Bar. This option can also be selected by using the icon marked as FF in the toolbar. 
 
The selection of above options opens up a Window Dialog Box.  The following information 
needs to be furnished on this Window Dialog Box: 

• Factors (i.e., the number of factors, n) 
• Levels   (i.e., the number of levels of each factor, s) 

 
For the generation of Randomized Layout of Fractional Factorial Plan, enable the check 
box of the Randomized Layout button. If the Check Box is left disabled, the Fractional 
Factorial Plan without randomization will be generated.  
 
There are two more buttons on this Window Dialog Box viz. OK and Cancel. The Cancel 
button can be used to cancel the operation. On clicking the OK button, the next Window 
Dialog Box gets opens up. This dialog box consists of two radio buttons viz. 

• Main Effects 
• Main Effects and Two Factor Interactions  

 
Select one of these two Radio Buttons and Press OK. A new Widow Dialog Box opens up. 
This dialog box is for the information on the confounded interaction components. The user 
has to enter  
• Number of independent interaction components to be confounded  
• The confounded independent interaction components.   
 
The information in the above Dialog Box can be entered as per procedure of Complete 
Factorials with Confounding.  
 
The confounded independent interaction components are the set of Defining Contrasts or the 
Identity Group of Interactions. While entering the confounded interaction components, please 
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see that no less than three-factor interaction (including the generalized interaction 
components) gets confounded when the option Main Effects is selected. No less than five 
factor interaction components (including the generalized interaction components) gets 
confounded when the Option Main Effects and Two Factor Interactions is selected. Along 
with these options there are two more Buttons OK and Cancel. Press Cancel Button to cancel 
the operation and OK Button to get the Fractional Factorial Plan.  If a setup for generation of 
fractional factorial is possible it proceeds further, otherwise it gives an error message to the 
user, and prompts the user to select some different setup. SPFE makes this decision by 
checking whether the number of runs at least one more than the number of degrees of freedom 
for main effects or main effects and two factor interactions by using the following formulae. 
For main effect plans, it checks whether )1(1s −∗+≤ snr  is true or false. Similarly for main 

effects and two factor interactions, it checks whether 2
2 1)(s*C1)(s1s −+−∗+≤ nr n  is true or 

false where a = number of interactions in the defining contrasts and r = n – a.  These 
inequalities are taken only to ensure that the number of runs in the fractional factorial plan is 
at least equal to the degrees of freedom required.  
 
For the Generation of a Balanced Confounded Design, select the option Balanced 
Confounded Designs from the option Design Generation of the Menu-Bar. This option may 
also be selected using the icon marked as BCD in the Toolbar. On the selection of the option 
Balanced Confounded Designs, Window Dialog Box opens up. This Window Dialog Box 
consists of a Combo Box where the list of balanced confounded designs is displayed. Select 
any one of the designs from this list and Click the button Display Design to see the design 
(without randomization). For getting the randomized layout, click the Button Display 
Randomized Design. 
 
The option Analysis in the Menu-Bar consists of the following sub-options which are 
displayed as POP-Up Menus   

♦ Single Factor 
♦ Multiple Factor 
♦ Main Effects and Interactions  
♦ Single df Contrasts 
♦ User Defined Contrast 
♦ Look Up Table 
 

The options Single Factor, Multiple Factor and Look Up Table are activated and other options 
remain deactivated. Each of the options Single Factor and Multiple Factor have two sub-
options viz. Block Designs and UnBlocked Designs. For the analysis of data user has to 
create a data file in ASCII mode.  
 
Single Factor Experiments 
The option Single Factor is useful for the analysis of data from single factor experiments 
conducted using an unblocked (completely randomized) design or a block design. If the data 
is generated through a completely randomized design, then select the option Unblocked 
Designs under the option Single Factor. If the data is generated from a block design 
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(randomized complete block design or an incomplete block design), then select the option 
Block Designs under the option Single Factor. 
 
As one selects Block Designs/Unblocked Designs, a Window Dialog Box will open up for 
browsing the File and it also contains OK and Cancel Buttons. First enter the file in the File 
Name Option either directly writing the complete path of the file or selecting the file through 
the Browse Button on the Window Dialog Box. It may be noted here that there is no 
dependence on the File Name and Path. From anywhere one can fetch the file.  
 
The Cancel button can be used to cancel the operation. On clicking the OK button, Progress 
Bar shows the execution of the result of Analysis of particular data file. Once the execution is 
over, the results are displayed on the screen. This output can be saved in a file using the 
option File from the Menu-Bar. The editing of the output if desired is also possible. For an 
Unblocked Design, the output consists of the following: 

ANOVA Table 
Source DF SS MS F-CAL Prob>F 
Treatments      
Error      
Total      

 
Here Source stands for source of variation, DF denotes degrees of freedom, SS denotes Sum 
of Squares, MS denotes Mean Squares, F-CAL denotes the computed F-value and Prob>F 
denotes the exact value of level of significance of equality of treatment effects.  
 
Below the ANOVA Table are displayed:  

• R-Square 
• RMSE (Root Mean Square Error) 
• General Mean 
• C.V. (Coefficient of Variation) 

 
This is followed by 

• Treatment Means and Their Standard Errors 
• All possible Pairwise Treatment Comparisons Prob>F (v × v matrix with 

diagonal elements as . and off-diagonal elements as exact level of significance 
of the equality of corresponding treatment effects) 

• If the treatments are equireplicated, then the critical differences at 1 % and 
5% level of significance are also displayed. 

 
Note: Once the file is selected and the analysis is carried out, the option User Defined 
Contrasts get activated. This option can be used for testing the significance of Comparisons of 
Interest. A Window Dialog Box opens up on selection of the option User Defined Contrasts. 
For details on this option see User Defined Contrasts.  

 
For a block Design, the output consists of the following: 
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ANOVA (Adjusted for Treatment Effects)  
Source DF SS MS F-CAL Prob>F 
Blocks (Unadj.)      
Treatments (Adj.)      
Error      
Total      

 
ANOVA (Adjusted for Block Effects)  

Source DF SS MS F-CAL Prob>F 
Blocks (Adj.)      
Treatments 
(Unadj.) 

     

Error      
Total      

 
Here Source stands for source of variation, DF denotes degrees of freedom, SS denotes Sum 
of Squares, MS denotes Mean Squares, F-CAL denotes the computed F-value and Prob.>F 
denotes the exact value of level of significance of equality of treatment effects.  
 
Below the ANOVA Table are displayed:  

• R-Square 
• RMSE (Root Mean Square Error) 
• General Mean 
• C.V. (Coefficient of Variation) 
 

This is followed by 
• Treatment Means and Their Standard Errors 
• All possible Pairwise Treatment Comparisons Prob>F (v × v matrix with 

diagonal elements as . and off-diagonal elements as exact level of significance of 
the equality of corresponding treatment effects, where v is the number of 
treatments) 

• If the treatments are equireplicated in each block, then the critical differences at 
1 % and 5% level of significance are also displayed. 

 
Note: Once the file is selected and the analysis is carried out, the option User Defined 
Contrasts get activated. This option can be used for testing the significance of Comparisons of 
Interest. A Window Dialog Box opens up on selection of the option User Defined Contrasts. 
For details on this option see User Defined Contrasts.  
 
Multiple Factor Experiments 
The option Multiple Factor is useful for the analysis of data from Multi-factor experiments 
conducted using an unblocked (completely randomized) design or a block design. If the data 
is generated through a completely randomized design, then select the option Unblock Designs 
under the option Multiple Factor. If the data is generated from a block design (randomized 
complete block design or an incomplete block design i.e. confounding of factorial effects), 
then select the option Block Designs under the option Multiple Factor.  For multiple factor 



SPFE 1.0 

 I-99

experiments, the ∏
=

=
n

i
i vs

1

 treatment combinations are renumbered automatically in 

lexicographic order from 1 to v , where si denotes the levels of factor i, i = 1, 2, …, n. The data 
is then analyzed as per usual procedure of block/unblocked designs for single factor 
experiments. For details of this analysis, one may see the Single Factor Experiments. 
 
Once the file is selected and the analysis is carried out, all the options viz. Main Effects & 
Interactions, Single d.f. Contrasts and User Defined Contrasts get activated. The option 
User Defined Contrasts can be used for testing the significance of Comparisons of Interest. 
A Window Dialog Box opens up on selection of the option User Defined Contrasts. For 
details on this option see User Defined Contrasts. The option Main Effects & Interactions 
is useful for partitioning the treatment sum of squares due to Main Effects and Interactions. 
Selection of the option Main Effects & Interactions from the Option Analysis of the Menu 
Bar gives: 
• ANOVA for Main Effects and Interactions (including DF, SS, MS, F-Cal and 

Prob>F) 
 
Below the ANOVA Table are displayed:  
• Effect Means along with their standard deviations. Here effect means include the 

means for all levels of single factor averaged over levels of all other factors, means for all 
level combinations of two factors averaged over levels of all other factors and so on. The 
effect means along with their standard deviations are displayed. 

 
This is followed by: 
• Probability levels of significance of all possible pairwise comparison of levels of 

single factor means averaged over levels of all other factor means. If the ith factor has 
si levels, then the order of the matrix of the probability levels of significance of all 
possible pairwise comparison of levels of ith factor means averaged over levels of all other 
factor means is a ii ss ×  matrix with diagonal elements as . and off-diagonal elements as 
exact level of significance of the equality of corresponding levels means) 

• Probability levels of significance of all possible pairwise comparison means of level 
combinations of two factors (all possible pairs if two factors) averaged over levels of 
all other factor means. If the ith factor has si levels, then the order of the matrix of the 
probability levels of significance of all possible paired comparison of means of level 
combinations of 1st and 2nd factors averaged over levels of all other factors is a 

2121 ssss ×  matrix with diagonal elements as . and off-diagonal elements as exact level of 
significance of the equality of corresponding level combination means) 

• If all the levels of the ith factor appear equal number of times in each block, then the 
critical differences at 1 % and 5% level of significance are also displayed. These 
critical differences are useful for comparing the equality of means of levels of ith factor 
averaged over levels of all other factors. 

• If all the level combinations of ith and thi′  factors appear equal number of times in each 
block, then the critical differences at 1 % and 5% level of significance are also 
displayed. These critical differences are useful for comparing the equality of means of 
level combinations of ith and thi′  factors averaged over levels of all other factors. 
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Single df Contrasts 
This option is quite useful for interpreting the results for quantitative factors when the levels 
are equi-spaced. On selection of the option Single df Contrasts from the option Analysis 
Menu-Bar after the analysis of block/unblocked design under Multiple Factor option is carried 
out, Window Dialog Box which consists of the List of treatment Contrasts opens up. User can 
select the treatments which are Qualitative in nature from the above List of treatments. This 
Dialog Box also consists of two buttons i.e. OK and Cancel. Cancel Button will cancel the 
operation and OK Button will produce the result according to the selection made to the List. It 
displays the following results: 
• Contrast Estimate and Variance of the estimated contrasts 
• ANOVA Table for Single d.f. contrasts generated through orthogonal polynomial) which 

consists of Effects (Treatment Contrasts), DF, SS, MS, F-CAL and Prob>F.  
 

User Defined Contrast 
This is one of the fascinating features of SPFE. This option can be used for testing the 
significance of Comparisons of Interest. A Window Dialog Box opens up on selection of the 
option User Defined Contrasts. User has to enter the number of contrasts or sets of contrasts 
one wants to test. These contrasts can be single degrees of freedom (d.f.) or multiple degrees 
of freedom. There are two more Buttons on the Dialog Box viz. OK and Cancel. Click on 
OK button, opens up a Window Dialog Box for the first set of contrasts. On this Window 
Dialog Box, enter the d.f. of first set of contrasts and the coefficient of treatment effects in 
these contrasts. Please ensure that the sum of the coefficients for each row is zero. One can 
enter the names for identification of these contrasts. On clicking OK button Window Dialog 
Box for the second Set of Contrasts opens up. This process is continued till information 
regarding all contrasts or set of contrasts is entered. On Clicking the OK button on the 
Window Dialog Box of the last set of contrasts, one gets 

♦ Name of the User Defined Contrast  
♦ Contrast Estimate 
♦ Source 
♦ DF (Degree of Freedom) 
♦ SS (Sum of Squares) 
♦ MS (Mean Squares) 
♦ FCAL (F calculated Value) 
♦ PROB>F (Probability >F) 

 

Look Up Table 
SPFE gives the Analysis of Symmetrical and Asymmetrical, Factorial Experiments. The 

analysis is carried out by writing the ∏
=

n

i
is

1

 treatment combinations in lexicographic order and 

then renumbering them from 1 to ∏
=

n

i
is

1

, where si denotes the levels of factor i, i = 1, 2,…, n.  

The option Look Up Table essentially gives this identity relationship between the 
renumbered treatments and the treatment combinations.  On selection of option LookUp 
Table from the option Analysis from the Menu-Bar, Window Dialog Box with options of 
Factors and Levels opens up. User is required to enter the number of factors and levels of 
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each of the factors. On Clicking OK button one gets the identity relationship between the 
renumbered treatments and the treatment combinations. Cancel Button can be used to cancel 
the operation. 
 
Probability Generation 
The option of Probability Generation is available in the Menu-Bar. It generates the 
Probability for t-, Chi-square at n degrees of freedom and F- at 1n  and 2n  degrees of freedom. 
The following options are available under the Probability Generation:  
• t-distribution 
• Chi-square Distribution 
• F-Distribution 
 
On selection of the option t-Distribution, user has to enter: 
• X, the value above which we want to compute the probability 
• n,  the degrees of freedom  

 
There are two more buttons OK and Cancel on this Dialog Box. Cancel Button is used for 
canceling the operation and click on the OK button, generates the probability of t-Probability 
greater than X i.e. Prob ][ Xt > .  
 
On selection of the option Chi Square Distribution, user has to enter: 

• X, the value above which we want to compute the probability 
• n,  the degrees of freedom  

 
On entering these values, it generates the probability of Chi-square distribution greater than X 
i.e. Prob ][ 2 X>χ .  
 
On selection of the option F- Distribution, user has to enter: 

• X, the value above which we want to compute the probability 
• 1n  and 2n , the degrees of freedom 

 
On entering these values, the package generates the probability of F- distribution greater than 
X i.e. Prob ][ XF > .  The procedure of entering the required values and output are displayed in 
the following figure. 
 
Help 
The last option in the Menu-Bar is Help. The option Help consists of two options viz.  

• About SPFE 
• Contents 

 
About SPFE 
It gives the information about the Version of SPFE, team that developed SPFE and the 
Contact persons. 
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Contents 
It gives the Complete Help of SPFE with Index, Contents and Search Facility. Under the 
option Contents, the help on the following: 
• Getting Started with SPFE 
• Design Generation 
• Randomization 
• Analysis 
• Probability Generation 
• SPFE Editor 
These Contents have further sub-options. The option Index can be used for seeing the indexed 
Words.  Find option can be used as search facility. 


